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 Training Notes 
 Wellspring Fax Service 03 Dec 2009 

Wellspring Software, Inc., offers a Fax Service that can be used with PrintBoss from any computer that has 

internet access.  Faxes are sent from PrintBoss through the internet to a fax data center.  The data center then 

sends the faxes to any number in the United States or Canada.  Please note that overseas faxing is not available at 

this time. 

ORDERING 

The fax service is a PREPAID service.  Order prepaid pages from our web site using your Wellspring Software 

web account and password.  If you do not have an account, you can create one online.  This same account and 

password must be used with the PrintBoss program to allow PrintBoss to communicate with our server.  You may 

choose to setup an automatic re-order quantity in PrintBoss so you always have the fax pages you need.  All users 

can share one account or you may set up individual fax service accounts for each user.  To create an account: 

1. Go to www.PrintBoss.com or www.WellspringSoftware.com.   

2. Click on SignIn in the top right corner of the Home page. 

a. Enter your Email Address or User Name and click Sign In OR 

b. Click the Create New Account link if you do not have an account 

3. Select PRODUCTS / PRINTBOSS FAX SERVICE from the drop down menu at the top of the page.   

4. Select the number of pages from the drop down menu near the bottom of the page and click Add to Cart.  

Remember, you may share fax pages with all PrintBoss users or set them up individually.  

5. Check the Auto Reorder box on the first line and choose quantity to set automatic reorders. 

6. You may also select to receive email confirmations for successful or failed faxes. 

a. Enter the email address to receive confirmations for this account. 

b. Select Email on Success, Email on Failure, or both. 

c. Click Save to save the email confirmation settings. 

7. Sign Out when you are finished. 

NOTE: 

The price per page decreases with larger quantities of prepaid pages. 

FAX SETUP 

1. Open the PrintBoss Master Application. 

2. Click on the Options menu and select Fax Settings /Wellspring Fax Service. 

3.  Fill in the following fields. 
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a. Enable Fax Service - This check box is workstation and user specific.  It must be checked for the fax 

service to be activated.  The name at the end of the check box legend identifies the active user. 
b. Account Information – Enter the appropriate information for the identified user.  

i. Used by All PrintBoss Users – Check this option to force all PrintBoss users to share the 

same account information.  This is independent of Misc Settings. 

ii. User Name – Enter a User Name.  This must be the same name used to Sign In to the 

Wellspring web site to order prepaid fax pages.  In most cases, this is an email address. 

iii. Password – Enter a Password.  This must be the same password used to Sign In to the 

Wellspring web site. 

iv. A User Name and Password must be entered and the account queried to view the following 

fields: 
1. Log File Image Treatment – This option determines how the log file images are 

treated.  The default value is Separate Files. 

2. Log Retention – This option determines how long PrintBoss will keep a record of each 

fax. 
3. Blank Field – This field is above the Pack button and displays the Wellspring Software 

web user ID after the account is queried. 
4. Pack – Click this button to pack the log table.  Faxes older than the Log Retention 

period will be deleted. 

c. *** Fax Service Account Status – This section lists the status of the account selected to process 

faxes and relates to the account created on the Wellspring Software, Inc., web site to purchase the 

fax pages.  You may have a single account for all users or create separate accounts for each user.   

i. Account – This button changes based on the status of the account. 

1. Query Account – Click this button to poll the Wellspring Software web site to 

update the fax service status for the account.  This button is visible when you first 

enter the Fax Service window. 
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2. Refresh Account – The Query Account button changes to Refresh Account 

after you click on it once.  Click on this button to re-polls the web site and 

updates the fax service status for this account. 

3. Confirm Account – The Query Account or Refresh Account button updates to 

Confirm Account when changes are made to the Account Information section 

after the account has been queried at least once.  This re-polls the Wellspring 

Software web site and updates the fax service status for this account. 

ii. Required PrintBoss S/N – This field displays your PrintBoss serial number after the 

account is queried.  This field is only editable from the web site. 

iii. Prepaid Pages – This field displays the remaining prepaid pages in your account after 

the account is queried.  

iv. Edit Account – Click this button to open the Wellspring Software web site to order 

additional prepaid fax pages or make changes to your account settings.  PrintBoss 

automatically logs you in to the web site based on the information in the User Name and 

Password fields. 

v. Auto Reorder Qty – Displays the Auto Reorder quantity set up on the Wellspring 

Software web site.  This value can only be set on the web site. 

vi. Auto Reorder Level – Displays the Prepaid Pages level when the Auto Reorder Qty 

will be initiated.  This field only displays when there is a value in the Auto Reorder Qty 

field and can only be set on the web site or by calling Wellspring Software. 

vii. Email Confirmations – Displays the email address to receive confirmations for 

successful of failed faxes.  You can choose one or both check boxes.  These can only be 

set on the Wellspring web site by clicking on the Edit Account button. 

1. OK – Confirms a fax was successfully sent. 

2. Failed – Confirms a fax failed. 

d. Misc Settings – These fields contain options for handling faxes. 

i. Used by All PrintBoss Users – Check this option to force all PrintBoss users to share the 

same settings under Misc Settings.  This is independent of the Account Information. 

ii. Assumed Area Code if none passed – Enter the default area code PrintBoss should use 

if no area code is included with the fax number. 

iii. Pause prior to each fax in batches – This feature allows PrintBoss to determine when to 

pause while processing faxes.  There are 3 choices from the drop down menu. 

1. Never – PrintBoss will not pause for any fax document. 

2. Invalid Phone Number – This is the default value.  PrintBoss will only pause 

during processing when the phone number is not properly formatted (10 digits or 

7 digits with assumed area code).  PrintBoss cannot tell if the phone number is no 

longer in service.  If a number is no longer in service, the fax will fail. The failure 

will be indicated in the Fax Service Log (see end of this chapter). 

3. Always Pause – PrintBoss will pause at ever fax document when this option is 

selected.  This is only recommended if your intention is to manually enter the fax 

number for each document.  

iv. Fax Header – Edit this field to include header information at the top of each sent fax.  

You may use variables (items inside of brackets { } that change from document to 

document) as well as fixed text. 

1. A sample header is included.  You will want to edit at least the company name 

and number in this sample.   

2. Other suggestions are provided in the drop down menu.  You may edit any of 

these samples or create one of your own.  Drag out the left or right edge of the 

dialog to lengthen the field and display a wider viewable area.  

v. Combine Pages with identical phone #s when printing batches – PrintBoss Enterprise 

combines all faxes with the same phone number into one call when this option is selected.  

Only one cover page will be sent (if a cover is included).  Standard PrintBoss will treat 

each page as an individual fax (separate call). 
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vi. Print status character of "S" (Skipped) when fax phone is blank – Select this option 

to enter a capital S in the Printed column of the work file when there is no fax number.  

Faxes that fail to send for whatever reason leave an error code of "x" in the document 

work file.  This lower-case error code prohibits the work file from being archived or 

deleted.  Select this feature to allow PrintBoss to skip a fax and record a status of S in the 

work file.  PrintBoss will treat the document as completed.  The skipped record can be 

handled separately or ignored. 

vii. Confirm fax success before moving Work Record to archive (or deleting) – Select 

this option to prevent a document from being removed from the Work File record until 

the fax is confirmed as sent successfully (or has an "S" for properly skipped). 

viii. Include Cover Page when faxing batches – Select this option to include a cover page at 

the beginning of each sent fax. 

ix. Fax Number Source – Select the variable(s) PrintBoss uses for the fax service.   

1. FaxSvcFaxNo – This is a unique variable to assign to the fax number. 

2.  DocMisc – This variable is sometimes used for other data.  It may be best to 

only select the FaxSvcFaxNo variable if you are not sure you are using DocMisc 

for something else. 

x. Log File Poll Period – Select the interval (in minutes) PrintBoss polls the web site for 

updates on fax sent status.  The default value is 4 minutes.  The status can be viewed on 

the Fax Service Log under the Utilities menu. 

xi. FaxService Comm. Method – Set this option to Standard Service unless directed to 

change by a Wellspring Software, Inc., technician. 

e. Cover Page Fields Default Values – These settings apply to cover pages included with faxes 

unless their values are overwritten specifically in the PrintBoss Form File. 

i. Cover Page Fields used by all PrintBoss Users – Check this option to force all 

PrintBoss users to share the same Cover Page settings. 

ii. Cover Page File – Select a cover page file.   

1. PrintBoss includes a sample cover page that may be used as a default.   

2. The document selected here is used as the cover for all faxes unless an alternate 

cover is specifically designated in the PrintBoss Form File. Usually this is an 

html document with variable names that are filled at print time.   

3. Alternate cover pages can be saved in {PBDir}\FaxService\Cover Pages folder 

and accessed with the Open  button at the end of this field. 

iii. Text Edit – Select this button to edit the Cover Page File using Notepad. 

iv. HTML Edit – Select this button to edit the Cover Page File using Word.  Select Save As 

and choose the correct name with the format set to Web Page, Filtered (*.htm, *.html) 

when you are finished editing. DO NOT save as a regular Web Page or the variables may 

not work properly. 

v. To – Enter the appropriate variable for the To: name.  The default value is {DocRecip}. 

This may be overwritten by values set in a PrintBoss Form. 

vi. From – Enter the appropriate value for the From: name.  Typically this is your company 

name and is typed in the field.  This may be overwritten by values set in the PrintBoss 

Form. 

vii. Re – Enter the appropriate value for the Re: subject. Text or variables may be used in this 

field. This may be overwritten by values set in the PrintBoss Form. 

viii. Cover Page Message – Enter a default message included on the cover page (if a cover 

page is included).  You may edit this message or delete it and enter one directly on the 

Cover Page File.  This field may be overwritten by values set in a PrintBoss Form. 

ix. Company Name/Address – Enter the appropriate default values for your company in 

these fields.   

1. Leave a field blank if you do not want to use it.   

2. These fields are referenced by the PrintBoss default Cover Page.  You may edit 

the cover page so it does not reference these fields or enter the information 

directly into the cover page.   
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3. These fields may be overwritten by values set in a PrintBoss Form. 

x. Test Fax Number – Enter the number of a local fax machine to test the fax.  Most often 

this is an inbound fax number in your office so you can verify the fax looks the way you 

expect.  Include the area code if it is different from Misc Settings / Assumed Area 

Code. 

4. Testing – Click the Send Test Fax button.  The Fax Service Send dialog opens.   

a. You may edit most of the fields before clicking the Send Fax button at the bottom of the dialog. 

b. The fields display the values entered in the Cover Page Fields section when the Cover Page 

Fields Default Values checkbox is selected.   

c. Click the Send Fax button to test the fax settings.  The result will appear in the Fax Status 

section at the bottom of the page. 

d. Sent test faxes count toward your prepaid pages. 

5. Click OK to save changes made to the Wellspring Fax Service Options dialog. 

FORM SETUP FOR FAXING 

The PrintBoss Fax Service feature is enabled on a form-by-form basis.  This only takes a few steps: 

1. Open the PrintBoss Master Application. 

2. Click on the Edit menu and select Form Files.  

3. Highlight the form you want to fax and click the Editor button.  

4. Increment Copies by one on the Settings Tab.  This new copy will be treated as the fax copy. 

5. Select the Multi-Parts & Printers tab. 

6.  Set the Destination Printer/Device for the new copy to < Fax Service>.  A fax button will appear at the 

top of the View for this form. 

���� See Training Notes entitled Form Files for more information on Modify from the Document View. 

7. Click OK. 

FAXING 

Printing documents from the accounting software proceeds as normal.  Typically, the document Original and 

Copy are set to print/fax immediately.  Unlike faxing through a local modem, there is no delay in the fax service 

process. The faxes are sent out immediately through the internet.  It may take 1 to 10 minutes for the fax to be 

sent from the fax service. 

When the Print Time on the Multi-Parts & Printers tab of the Form Editor is set to Batch, documents can be 

faxed manually from the View or directly from the Work File. See Manual Fax on Demand below for step-by-

step instructions on faxing from the Work File. 

MANUAL FAX ON DEMAND 

When Enable Fax Service is checked at the top of the Fax Service Options dialog, all document Views will have 

a Fax button at the top of the window near the Close button.   

1. Open the PrintBoss Master Application. 

2. Click on the File menu and select Open Document Work Files or Open Document Archives.   

3. Highlight the desired work or archive file and select Browse.   

4. Select the appropriate document from the list.  There are two ways to proceed from this point. 

a. Click View.   

i. Click on the Fax button to manually send this document.  There is a short delay while 

PrintBoss creates the cover page.  The Wellspring Software Fax Service Send window 

opens.  
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ii. Enter a number in the Fax Number field if it is blank (default).   

1. A fax number will appear if either of the DocMisc or FaxSvcFaxNo variables is 

assigned in the PrintBoss Form. 

2. These assignments can be static (same value for all documents using this form) 

or dynamic.  Dynamic variables capture a value for each document. 

iii. Check the Cover Page option to include your default cover page.   

iv. Click Send Fax when you are finished. 

v. Click Close to close the View. 

b. Click Print. 

i. Select Allow Reprints. 

ii. Select the copy identified as <Fax Service>. 

iii. Adjust the Scope to include additional documents if desired. 

iv. Click Print Start to send the fax(es). 

v. Click Done to close the Print Copies Dialog. 

5. Review the File Browse table.  The Printed column displays a capital X when the fax is sent successfully.  

A small case x displays when the fax was not sent successfully.   

a. Right click on a document and select Edit to view the Status Log.    

b. The Status Log records both e-mail and fax activity.    Example:   

10/09/2009 10:15:27A Copy=1 Faxed Successfully. 

c. When the fax is still pending at the fax server, there will be a slash (/) in the Printed column of the 

Work File. 
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ASSIGNMENTS 

Assignments can be either Static or Dynamic.  An explanation of these choices follows. 

Static Assignments 

Assign static values to the DocMisc or FaxSvcFaxNo variables to set a single fax number for ALL sent faxes.  For 

example, the office manager may need a copy of all invoices.  The invoice form may contain an entry similar to 

the following: 

 #Assign FaxSvcFaxNo, "555-555-1212" 

These assignments must be made in the Runtime Objects tab of the PrintBoss Form (EDIT / FORM FILES / 

<highlight the PrintBoss Form> / EDITOR). 

Dynamic Assignments 

Dynamic assignments are the heart of automatic faxing.  There are 2 ways to create a dynamic assignment.  Use 

one method or the other, not both. 

INCLUDE IN SOURCE REPORT 
Modify the PrintBossMisc formula to represent the fax number variable in the source report if there is a PrintBoss 

Trigger.  It is important this formula format the number to include the area code.  

PICKED OFF OF CAPTURED REPORT BY PRINTBOSS 
This method requires the recipient's fax number is displayed somewhere on the source report.  PrintBoss can 

capture this information and blank it out (if desired).   

1. Print a document to PrintBoss containing a fax number.  

2. Click on the File menu and select Open Document Work Files on the PrintBoss Master Application.  

3. Select the appropriate form and click Browse. 

4. Select a document and click View. 

5. Right-click anywhere in the View and select View Raw Capture. 

6. Locate the fax number on the page.  Double click on the text to open up the Captured Text Command 

Properties dialog. 

7. Select the Click to Assign to Variable bar on the top right of the dialog. 

8. Change the Variable Name from ReNameMe to FaxSvcFaxNo. 

9. Check the following fields:  

a. Add together fields in horizontal range 

b. Capture Raw Text Objects Only 

c. Left Trim 

d. Right Trim 

e. Blank Out After Capture (optional – hides fax number on printed document) 

���� Some reporting engines (such as the latest Crystal Reports) tend to break up text fields.  A good 

practice is to click on the +/- button that follows the Horizontal field so it become to.  Set the ending 

coordinate far enough to the right to pick up a 10-digit fax number.  

10. Click OK.  PrintBoss adds this assignment to the top of the RunTime Objects in the Form 

11. Right-click on the page and click on View Raw Capture to return to the formatted document.  

12. Click the Fax button on the top right corner of the View to test the assignment.  The Fax Service Send 

dialog displays the address fields filled with the assigned values. 

13. Click Send Fax to complete the test. 

14. Click Close to exit the View. 

���� See Training Notes entitled Capturing and Assigning Text for more information.  
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VARIABLES 

There are several variables that may be assigned in a Form File to define values for the cover page and fax 

number. 

���� See Training Notes entitled Form Files for more information on Assignments. 

A list of the fax service variables and their purpose is included in Appendix E of this document. 

FAX SERVICE LOG 

PrintBoss keeps a log of the faxes sent through the Fax Service.  The Fax Service Send Log indicates the Status 

of the fax, Date and Time the fax was sent, the name of the PrintBoss user (Operator) who sent the fax, the name 

of the PrintBoss Form used to send the fax, if a Cover Page was included, and the number of Pages sent.  This is 

the number of pages that will be deducted from your account.  The log also displays the Document Number and 

Recipient of the fax if a Fax Service variable is defined. 

1. Open the PrintBoss Master Application. 

2. Click on the Utilities menu and select Fax Service Log. 

 

The log Status indicates whether a fax is pending, sent, or failed.  The frequency of the status updates is 

determined by the Log File Poll Period defined on the Wellspring Fax Service Options dialog.   

3. Click the Update Status button at the top of the Fax Service Send Log to manually update the log. 

4. Select Show Fax Errors Exist Flag on Master Application Screen to display failed faxes in red text in 

the lower left of the Master Application screen.   

 

a. Right click on the red text to view options such as resend the fax or abandon the record. 

5. Right click on a record to view a list of options for handling the record.  The options include: 

a. Abandon Failed Record 

b. Resend 

c. View Cover Page 

d. View Body Page(s) 

e. Delete Record 

6. Click on the Order Select drop down menu to choose a sort order for the log. 

7. Click on Done when you are finished. 



 

9 

Appendix 

E 
AAAAPPENDIX PPENDIX PPENDIX PPENDIX E:E:E:E:        FFFFAX AX AX AX VVVVARIABLESARIABLESARIABLESARIABLES    

Variables may be assigned in a form to define values for the fax cover page and fax number.  Assignments made 

in a specific form file will override the settings in the FAX SERVICE OPTIONS screen. These values will then 

be global for all users who access this form.  A description of the available variables follows.  

{CURRENTDATE} 
This variable will display the current date at the time the fax is sent.  See the Current Date substitution function 

for more options. 

{CURRENTTIME} 
This variable will display the current time at the time the fax is sent.  See the Current Time substitution function 

for more options. 

{FAXSVCATTACHMENTS} 
In earlier releases of PrintBoss, the document sent to PrintBoss was the only document faxed (along with the 

optional cover page).  The {FaxSvcAttachments} variable can be used to define the file path and name of other 

documents to fax along with the document sent to PrintBoss. 

{FAXSVCCVRADS1} 
This is the first address line for the SENDING entity. By default, the value of this variable is pulled from the entry 

in the Ads1 field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRADS2} 
This is the second address line for the SENDING entity. By default, the value of this variable is pulled from the 

entry in the Ads2 field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRADS3} 
This is the third address line for the SENDING entity. By default, the value of this variable is pulled from the 

entry in the Ads3 field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

FAXSVCCVRCOMPANY} 
This is the Company Name for the SENDING entity.  By default, the value of this variable is pulled from the 

Company Name entered on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRFAX} 
This is the fax number for the SENDING entity. By default, the value of this variable is pulled from the entry in 

the Fax field on the WELLSPRING FAX SERVICE OPTIONS screen. 
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{FAXSVCCVRFILE} 
The Cover Page File defined on the WELLSPRING FAX SERVICE OPTIONS window applies to all faxes.  A 

different file path and name can be assigned to the {FaxSvcCvrFile} to define cover page files for different forms 

of different users. 

{FAXSVCCVRFROM} 
This is the name of the SENDER.  By default, the value of this variable is pulled from the entry in the From: field 

on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRMSG} 
This is the message body used on the fax cover. By default, the value of this variable is pulled from the entry in 

the Cover Page Message field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRPHONE} 
This is the phone number of the SENDING entity. By default, the value of this variable is pulled from the entry in 

the Phone field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRRE} 
This is the regarding message (subject) used on the fax cover.  By default, the value of this variable is pulled from 

the entry in the Re: field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCCVRTO} 
This is the name of the RECEIVING entity.  By default, the value of this variable is pulled from the entry in the 

To: field on the WELLSPRING FAX SERVICE OPTIONS dialog. 

{FAXSVCFAXNO}) 
This is the value of the fax number used to SEND the fax.  You may replace {FaxSvcFaxNo} with {DocMisc} if 

{DocMisc} is already assigned in the form to the correct fax number.  Set the Fax Number Source field in the 

WELLSPRING FAX SERVICE OPTIONS screen to the correct variable. 

{FAXSVCHEADER} 
The Fax Header defined on the WELLSPRING FAX SERVICE OPTIONS window applies to all faxes.  A 

different fax header can be assigned to the {FaxSvcHeader} variable to define separate fax headers for different 

forms of different users. 

Assignments made in a specific form file will override the settings in the FAX SERVICE OPTIONS screen. This 

value will then be global for all users who access this form. 

 


